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Dialer Menu
The dialer menu is used to open, close and save dialers and to control and setup the 
modem. The menu options are described below.

File is used to open or create new dialers, or to save and close open dialers.
Edit is used to edit the currently displayed dialer.
Options is used to setup the way the application looks and runs.
Modem is used to pick up or hang up the modem, reset the modem, setup the modem, 

and control the modems speaker.



Mouse Navigation

Using the mouse
The mouse or some other pointing device is used to navigate the menu structures.    Use 
the left mouse button to select and execute the touch tone commands.    Use the right 
mouse button to select the command button without executing the touch-tone commands.



File Menu (Dialer)
New is used to create a new phone dialer. When new is selected the setup form is 

displayed which allows you to name your dialer and organize a menu.
Open  is used to select existing PhoneWorks dialers using standard open file dialog. The

open file dialog displays all of the existing PhoneWorks dialers in the current    
working directory.    You have the option of opening one or many dialers at the 
same time. To open one dialer select the file to open and press OK. To open 
multiple dialers enter a wild card expression for the file name. All files matching 
the wild card expression are loaded. more

Save is used to save the dialer that is currently being used. This command should be 
used when a dialer has been imbedded into an application and you want to save 
it as a separate file.

Save As is used to save the active dialer to another file name.
Close is used to close the currently selected dialer form.
Exit is used to close all dialer forms and shut down the Phone Works application.



Dialer File Open
The file open dialog allows one or many dialers to be opened. You can select OK to open all 
dialers in a directory (*.phm),    or you can use wildcards to open a subset of dialers.
File Name Opens
*.phm All dialers in the directory (default)
t*.phm All dialers that begin with a T in the directory.
t?.phm All two letter files that begin with a T in the directory. For example t1.phm is 

opened but test.phm is not opened)



Edit Menu (Dialer)
Dialer is used to modify the current dialer form using the setup form. After you make 

your modifications and save dialer, you can activate your changes by 
reselecting the edited dialer/service using the drop-down combo box on the 
dialer form.

Preferences is used to change the default Text and Bitmap editors. (NOTE: These editors 
must be in the DOS search PATH.)



Select Bitmap Editor
PhoneWorks allows you to select a bitmap editor of your choice using the menu item Edit 
Preferences Text Editor. This bitmap editor is used to cusomize your PhoneWorks 
buttons. By default PhoneWorks uses the Windows Paint Brush (pbrush.exe) which comes 
with Windows, however, you may select any bitmap editor.
Note: The directory path of the editor you chose must be in your DOS path statement.



Select Text Editor
PhoneWorks allows you to select a text editor of your choice using the menu item Edit 
Preferences Text Editor. This text editor is used when the menu item Options Note is 
selected which allows you to take notes while you are using PhoneWorks. By default 
PhoneWorks uses the Windows Notepad (notepad.exe) which comes with Windows, 
however, you may select any editor.
Note: The directory path of the editor you chose must be in your DOS path statement.



Options Menu (Dialer)
Toolbar displays and hides the toolbar from on the PhoneWorks screen.    The 

toolbar is displayed by default.
Backup backup the dialer menu.
Always on Top make PhoneWorks always the top application on the screen.
Calendar Displays a calendar which allows PhoneWorks to dial dates by selecting a 

date on the calendar. The format of the date is defined in the Modem 
Setup dialog.

Note Startup a notepad program for taking notes. By default this starts the 
Windows Notepad, however you can change this to any other program 
using the Edit Preferences Text Editor menu item.



Modem Setup
The modem setup form is used to tell PhoneWorks how to use your modem. For most 
people the default settings are fine.
Connector The serial port the modem uses (Default: COM1)
Baud Modem communication speed (Default: 2400)
Data Bits How many bits are used for data transmission (Default: 8)
Parity Parity bit used to detect faulty communications (Default: None)
Stop Bits Stop bit used to detect faulty communication (Default: 1)
Init Modem Initialization string which configures the modem. A detailed list of modem 

initialization commands is in your modem's user's guide. (Default: 
TX3EVM1S6=0)

Dial Prefix Dialing prefix used to get an outside line if you are in an office or hotel. 
This prefix is appended to all Dialer Numbers and any Dialer command 
which has the Use Prefix option turned on.

Date Format Date format used to format calendar dates, M=Month, D=Day, Y=Year. If 
needed MM, and DD place a zero (0) in front of single digit months and 
days, YYYY displays the century as well as the year . To display the 
calendar select Options Calendar. (Default: MM#DD#YY)



Modem Menu (Dialer)
Pick Up/Hang Up picks up or hangs up the modem. When the modem is picked up the 

currently selected Service Number is dialed.
Reset resets the modem to its startup condition (Note: if the modem is off the

hook, reset will hang up the modem).
Setup Setup is used to configure the modem's port connector, baud rate, 

data bits, parity, and stop bits. Setup also allows a dialing prefix to be 
entered.

Speaker If your modem has a speaker, the Speaker menu option allows the 
speaker to be turned on and off.



Setup Menu
File is used to create a new dialer service, save or close the current service, or exit 

PhoneWorks.
Edit Select Edit to organize the menu items.



File Menu (Setup)
New creates a new dialer.
Open is used to select and load an existing PhoneWorks file. 
Save is used to save new or modified dialer files.
Save As allows dialer command files to be saved into a new file name.
Close is used to close the dialer setup form.
Exit is used to close all dialer forms and shut down the Phone Works application.



Creating a Dialer
Dialers are created using the setup form. The setup form allows a dialer service to be 
created with    a menu of buttons. Each button can have sub-buttons which are displayed 
when a button is selected. The procedure for creating a dialer is described below.

1. Select New from the File menu, the Setup form is displayed.
2. Enter a service name for the dialer you are creating.
3. Enter the phone number of the service.
4. Insert a menu items by using the:

Mouse: Click the insert button
Menu: Select Edit Insert
Hot Key: ALT-I

5. Select special options which control how the menu item works
Hang Up: will hang up the modem when the button is pressed.
Goto Previous Menu: will back up one level in the menu.
Use Prefix: will insert the prefix (defined in the Modem Setup Menu) before the 

button's command.
Show Calendar: displays the calendar for entering dates when the button is pressed. 

The date format is entered in the number field.
6. Select a button to display with the menu item by

Mouse: Click on the button picture. An array of buttons. Select the button you want by
clicking on a button in the array. (See Customizing Buttons to create your own 
buttons.)

Menu: Select the edit menu option Button. (ALT-EB)
7. REPEAT step 4 until all the menu items are defined. If you need to change the way the 

menu is organized continue to step 7.
8. Organize the Menu by using the:

Mouse: Click the arrow keys to move the menu item up, down, left, and right. The 
position of the menu item in the list determines where the item is placed in 
the menu structure

Menu: Select the edit menu options Move Up, Move Down, Promote, Demote to 
organize the menu structure.



Customizing Buttons
PhoneWorks has a one hundred button array which is used for customizing your dialer 
button menus. A generic set of buttons is included in PhoneWorks, however, you may 
change these if you like,by selecting Edit Buttons from the menu above the button array. 
The buttons are stored in a file called buttons.bmp.
There are a few things to remember when you are editing the buttons.

1. The size of the bitmap must not be changed.
2. The bit map can not have more than 16 colors
3. The top left button in the array is the default button which is used when you create new 

menu items. If you change this button, you will be changing all the default buttons.



Add Menu Item
Using the setup form, menu items can be easily added to a menu structure; the step-by-
step procedure is described below:

1. Press the insert button. A new command will be added to the list and the cursor will jump
to the data entry area where you can enter a new command.

2. Enter a command description.
3. Enter the numbers or letters that should be dialed when you select the command from 

the dialer form.
4. Select special options which control how the menu item works

Hang Up: will hang up the modem when the button is pressed.
Backup count: allows backing up in your menu tree count indicates the number of 

levels to backup.
Use Prefix: Appends the prefix to the Number. The prefix is defined in Modem 

Setup
Show Calendar: Displays the calendar when the button is pressed. The date format for 

the calendar is defined in the Number field.
5. If necessary use the arrow buttons to move the menu item to it's correct place in the 

menu structure.



Delete Menu Item
Using the setup form, menu items can be easily deleted from a menu structure; the step-
by-step procedure is described below:

1. Select the menu item you want to delete using
Mouse: Click on the menu Item
Key Board:Highlight the menu item using the arrow keys.

 2. Delete the menu item using
Mouse: Click on the Delete button.
Menu: Select Delete from the Edit menu.
Hot Key: ALT-D



Insert a Menu Item
Using the setup form, menu items can be easily inserted to a menu structure; the step-by-
step procedure is described below:

1. Select the existing menu item which should precede the menu item you want to insert.
2. Insert a menu item using

Mouse: Click on the Insert button.
Menu: Select Insert from the Edit Menu
Hot Key: ALT-I

3. Enter the information for the new command.



Edit Menu Item
Using the setup form, menu items can be easily modified, the step-by-step procedure is 
described below:

1. Select the menu item you would like to edit..
2. The item's information will be displayed in the field entry area above the list box.
3. Make modifications as necessary; the changes are made to the list box as you type the 

changes.
4. Select OK to save the changes and exit back to the Dialer form.

NOTE:
The changes are not shown on the Dialer form until you reselect the edited service using 
the combo box on the dialer form.



Edit a Dialer
Dialers are created and modified using the setup form. There are two ways to load the 
information for editing, from the Dialer form or from the Setup form. Both procedures are 
for editing a dialer are described below.

From a Dialer Form
1. Display the dialer you would like to edit by selecting it using the drop-down combo box or

by opening the file using the File Open menu item.
2. Select the Edit Dialer option from the Edit menu.
3. The setup form will be displayed with the dialer information.
4. Modify the Dialer as necessary.
5. Select File Save from the File menu.

From the Setup Form
1. Open up the setup form by selecting New from the File menu or Dialer from the Edit 

menu.
2. Select the Open option in the File menu on the setup form.
3. The dialer information will be displayed on the setup form.
4. Modify the Dialer as necessary.
5. Select File Save from the File menu.



Organizing a Dialer Menu
Dialer menus are organized using the setup form. From this form the dialer is given a name 
(called Service) a number (which is used to dial the service), and buttons which can be 
customized for each dialer/service. Buttons are organized in a parent-child relationship 
where each button can have child buttons which are displayed when a parent button is 
pressed. This parent-child relationship is defined by indenting the menu items in a family 
tree format. The following concepts describe how this menu structure works.

Change the Display Order
The display order of menu items on the dialer form is the same order that they appear on 
the list in the setup form. However, when these items are displayed on a dialer form only 
one generation is displayed at a time. The display order is changed using the Up and Down 
arrow buttons or from the edit menu.

Promote a menu item
Promoting a menu item causes that item to be displayed in the preceding menu level (i.e. 
its parent's menu level). Menu items are promoted using the left arrow button.

Demote a menu item
Demoting a menu item causes that item to be displayed as a sub menu item of the 
preceding menu. (i.e. it becomes a child of the preceding menu). Menu items are demoted 
using the right arrow button. (Note: A sub menu item can only be demoted one level below 
is parent menu item, PhoneWorks will not allow you to save a dialer that has incorrect 
relationships defined)

Backup to Previous Menu
This option allows the previous menu to be displayed again when the child command is 
selected. Then number of times to backup up can be selected using the drop-down box. If 
no backup count is selected the default is one backup level.

Hang Up
This option hangs up the modem when the menu item is selected on the dialer form.

Show Calendar
Displays a calendar which dials dates when a date is selected on the calendar. The date 
format is defined in the Command edit box. (ex. MM/DD/YY)

Use Prefix
Preceeds the Command with a prefix which is defined in the Modem Setup dialog. For 
example a 9- prefix could be used to reach an outside line.



Hints
Right Mouse Button is used to navigate the dialer menu without sending the command 
to the modem. This feature is useful when the service that you have called did not detect a 
command you sent and you need to move around the menu structure to resend the 
command without dialing extra commands.
Opening Two Dialers is useful if you have one dialer that has people's extensions and 
another dialer that has the commands to set up conference calls. Having two dialers open 
allows you to move back and forth to set up the conference call easily
Opening Dialer and Setup Forms Simultaneously is useful for viewing the menu 
structure in two formats, one generation at a time, and as a family tree. Changes made in 
the setup form do not take affect until the OK button, File Save, or File Save As menu items 
are selected. To view changes you have made, you must reselect the edited service from 
the drop-down combo box.
Always on Top is accessed from the Dialer Options menu. This feature is useful when you 
are using PhoneWorks to get information that is being entered into another application. 
Always on top keeps you from having to shuffle applications on top of one another.
Dialing Letters is possible by placing the cursor in the edit box below the numeric keypad
and typing letters on your keyboard. Once you press the Enter key or click on the check 
mark PhoneWorks converts the letters to numbers and dials them.
Using the Keyboard to Dial is possible by placing the cursor in the edit box below the 
numeric keypad and typing the number(s) on your keyboard. Once you press the Enter key 
or click on the check mark PhoneWorks dials the number(s) for you.



Trouble Shooting
I can't hear any thing through my modem's speaker. Some modems do not have 
speakers or their speakers do not project human voices very well. If you experience this 
problem try using a phone line splitter to hook another phone or speaker phone into the 
same phone jack as your modem. This configuration will allow PhoneWorks to use your 
modem to dial; but, you can hear through the regular phone.
When I edit a dialer the changes I've made do not show up on the dialer. Changes 
you make to a dialer do not show up until you reselect the dialer from the Services menu.



Modem Requirements
PhoneWorks only requires a modem that uses the Hayes AT command set, however, a 
modem with a speaker works best. If you don't have a speaker for your modem, you can 
use a speaker phone which is plugged into your modem or to a separate wall jack.

WARNING: If you are using PhoneWorks with the modem in one wall jack and a phone in 
another wall jack, be sure you hang up the modem AND the phone when you are finished. 
This is also true if you are using a phone line splitter to plug in a modem and a phone into 
the same wall jack.



Modem Problems
Speaker comes back on after running other communications programs When 
PhoneWorks is minimized other communications programs can control the modem. These 
programs will sometimes reset the modem which causes the speaker to be turned back on 
with out PhoneWork's knowledge. The speaker button does not correctly indicate the status
of the modem. This can be corrected by updating the speaker's status by clicking on the 
speaker button or selecting the Options Speaker from the menu.

The sound coming out of the speaker in inaudible Speakers on some modems are not
capable of transmitting human voices, and some modems are can not send audible signals 
to speakers. You will have to use a standard phone to listen to PhoneWorks. This can be 
accomplished using the LINE OUT phone plug on your modem or using a line splitter to 
attach a standard phone to your modem.

I have a Hayes compatible modem but it wont work with PhoneWorks Some 
modems require special initialization commands to allow the Hayes AT command set 
processing. Cousult your modem manual for special initialization strings. Initialization 
strings can be setup using the Setup Modem menu command.



Modem Commands
PhoneWorks provides the capability of sending AT commands directly to the modem. These 
commands must be enclosed in curly brackets {} and the command can not be imbedded 
in a regular command.

Warning:
You may get unpredictable results by sending commands directly to the modem, bypassing 
PhoneWorks to send initialization, setup, and dial commands will cause PhoneWorks to not 
know what commands have been sent to the modem. The status indicators may not 
accurately represent the status of the modem.

Valid Command
{L} Set the modem to its lowest volume
{L1} Set the modem on low volume
Invalid Command
{L0}555-1212{L3) Set the modem to its Lowest volume, Dial 555-1212, Highest volume



Promote
Moving a menu item to a higher level is called promoting. Promoting is performed on the setup form by selecting a 
menu item and clicking the left arrow button or from the edit menu by selecting Edit Promote.



Demote
Moving a menu item to a lower level is called demoting. Demoting is performed on the setup form by selecting a 
menu item and clicking the left arrow button or from the edit menu by selecting Edit Demote.



Dialer
A Dialer is form which displays a group of numbers you define, each number is defined by a separate push button 
and each push button can have sub-buttons defined. Examples of dialers are Bank-by-Phone menus, Phone Mail 
Menus, People on a project, People in a group or department, and Stock Quotes. As your use PhoneWorks you will 
find many ways it can simplify how you use the phone.



Generation
A Generation is used to describe a level of buttons. If you think of the menu structure as a family tree a generation 
would be all the children of a parent button. Each of the children could in turn have children which would be another
generation.



Form
A Form is window within PhoneWorks, this is called a multi-document interface (MDI). Currently there are two type 
of forms, dialer and setup. The dialer form uses your modem to make calls. The setup form configures dialers.



Using Different Button Files
Each dialer can use a button file which determines what buttons are displayed with each 
command. The buttons are in the BUTTONS.BMP file which is in your PhoneWorks 
installation directory. This file can be edited using any bitmap editor.

Steps for creating your own button file:
1. Create a new dialer using PhoneWorks. This will use BUTTONS.BMP by default
2. Copy BUTTONS.BMP to another file which will be used for editing.
3. Edit the NEW button file you have just created using any bitmap editor
4. Edit your dialer using an ascii text editor. Open the dialer file which will use the BMP 

file you have created. The dialer file will have a PHM extension.
5. On the first line of the dialer file locate the text BUTTONS.BMP and change this text to

the NEW filename you created in step 2. Do not modify anything else in the file.
6. Save your changes.
7. Run PhoneWorks to test your change. (note: you will have to reopen your dialer file 

for changes to take effect.)
WARNING: PhoneWorks expects a file called BUTTONS.BMP to be installed in the same file 
as the PhoneWorks executable (PHOWKS.EXE). Do not delete or rename this file.



Customizing Numeric to Alpha Conversion
Each dialer can use a conversion file which defines how letters are converted into numbers.
The default conversion for letters to numbers is in the STANDARD.ABC file which is in your 
PhoneWorks installation directory. This file can be edited using any ascii text editor. The 
format of the file is one letter per line formated as shown:
(letter),(number sequence)
Example
A,2
B,2
C,2
D,3
E,3
F,3

Steps for creating your own letter to number conversion file:
1. Create a new dialer using PhoneWorks. This will use STANDARD.ABC by default
2. Copy STANDARD.ABC to another file which will be used for editing.
3. Edit the NEW ABC file you have just created using the syntax described above.(see 

Example)
4. Use your ascii text editor to open the dialer file which will use the ABC file you have 

created.    The dialer file will have a PHM extension.
5. On the first line of the dialer file locate the text STANDARD.ABC and change this text 

to the NEW filename you created in step 2. Do not modify anything else in the file.
6. Save your changes.
7. Run PhoneWorks to test your change. (note: you will have to reopen your dialer file 

for changes to take effect.)

WARNING: PhoneWorks expects a file called STANDARD.ABC to be installed in the same 
file as the PhoneWorks executable (PHOWKS.EXE). Do not delete or rename this file.



Edit Menu (Setup)
Insert creates a new menu item below the currently highlighted menu item.
Delete deletes the currently highlighted menu item.
Move Up moves the currently highlighted menu item up one line.
Move Down moves the currently highlighted menu item down one line.
Promote promotes the currently highlighted menu item left.
Demote demotes the currently highlighted menu item to the right.
Button displays the button array which is used to select a button.



PhoneWorks TM 1.2 Registration Form/Invoice
Ordering by Credit Card: You can order from CIMware with your MC or Visa card by 
sending this order form to CIMware, P.O. Box 13313, Atlanta, GA 30324.    To print this order 
form, click on Print Topic in the File pull-down menu.    Alternately, you can print the ASCII 
text file ORDER.TXT.

Ordering by Check:    To order by check send this order form and a check to CIMware, P.O. 
Box 13313, Atlanta, GA 30324.    To print this order form, click on Print Topic in the File pull-
down menu.    Alternately, you can print the ASCII text file ORDER.TXT.    Payments must 
be in US dollars drawn on a US bank.

Ordering from PsL: You can order from Public (software) Library with your MC, Visa, 
AmEx, or Discover card by calling 1-800-242-4PsL (from overseas: 713-524-6394 or by 
CompuServe to 71355,470 or by FAX to 1-713-524-6398 request item #11240. THESE 
NUMBERS ARE FOR ORDERING ONLY. CIMware can be NOT be reached at these numbers. To
contact CIMware for information about dealer pricing, volume discounts, site licensing, the 
status of shipment, the latest version number or for technical information or to discuss 
returns, write the addresses below.

Ordering with CompuServe's Software Registartion Service: enter GO SWREG at the
! prompt and follow the menus.    PhoneWork's registration id is 2278.

Contacting CIMware: 
US Mail: CIMware, P.O. Box 13313, Atlanta, GA 30324
CompuServe: 70324,1654
AmericaOnline: PhoneWorks
Internet: PhoneWorks@aol.com 

or 
70324,1654@compuserve.com

Site licenses: A site license for PhoneWorks entitles an organization to receive 
one copy of the distribution package and duplicate the distribution disk for the 
specified number of copies.

Discount A 10% ($3) discount is available for 
anyone who sends a good example of how they 
have customized PhoneWorks for one or more 
Voice Messaging Systems. The example should 
be resuable and should include the button and 
abc file if appropriate. To qualify for this discount
you must order directly from CIMware using a 
credit card or check.



Prices guaranteed through December 1994.
PhoneWorks single copy: quantity ___ @ $ 30.00 ea. = _________
Site license for up to    9 copies:    quantity ___ @ $ 25.00 ea = _________
Site license for up to 100 copies:    quantity ___ @ $ 20.00 ea = _________
          (more than 100 copies are negotiable)
Georgia residents add sales tax + _________
Delivery option (check one)

__ AmericaOnline e-mail       No Charge
__ CompuServe e-mail       No Charge
__ Internet e-mail       No Charge
__ 3.5 inch diskette (add $5.00) + _________

10% Discount for sending example PhoneWorks File -    _________
Total payment       _________

Name: ________________________Date:________
Company: _____________________________________
Address: _____________________________________
City, State, Zip: _____________________________________
Country: _____________________________________
Day Phone: _______________    Eve:    ________________
E- Mail address: ___________________________
Credit Card 
(MC/VISA) __ __ __ __    __ __ __ __    __ __ __ __    __ __ __ __
Expiration __ / __
Signature __________________________
If you provide an electronic mail address, I will notify you about major updates as they 
become available.
How did you hear about PhoneWorks? ___________________________
What type of modem do you have? _____________________

Comments:



Discount
A 10% ($3) discount is available for anyone who sends a good example of how they have 
customized PhoneWorks for one or more Voice Messaging Systems. The example(s) should 
be resuable and should include the button and abc file if they have been changed. 
The discount is only available to those who buy directly from CIMware.
Please note that the example may be redistributed with future versions of 
PhoneWorks. Please remove any passwords from the file.



Overview
PhoneWorks allows you to use your PC and your Hayes compatible modem to control 
Automated Voice Messaging Systems. Day by day, these voice systems are becoming more
prevalent and more frustrating because each system has its own command structure. We 
all know these systems can give valuable information quickly, but most of us have avoided 
using them because the commands are hard to remember. Now, with PhoneWorks you can 
use your computer to control these systems and take the frustration away; PhoneWorks 
allows you to customize your own menu with picture buttons for any voice response 
system. These systems may include your voice mail, bank by phone, financial accounts, 
and stock quotes. There is no limit to the number of systems you can control. 
I hope you find this program useful, and please let me know if you have any suggestions or 
comments.



Copyright/License/Warranty

For ordering information, see the section Registration.

PhoneWorks(TM) Copyright (c) 1994 by John Littlefield - All rights reserved.
License Agreement and Warranty Disclaimer

You should carefully read the following terms and conditions before using this 
software.    Use of this software indicates your acceptance of these terms and 
conditions.    If you do not agree with them, do not use the software.
Shareware Version

You are hereby licensed to: use the Shareware Version of the software for a 30 
day evaluation period; make as many copies of the Shareware version of this 
software and documentation as you wish; give exact copies of the original 
Shareware version to anyone; and distribute the Shareware version of the 
software and documentation in its unmodified form via electronic means.    There 
is no charge for any of the above.

You are specifically prohibited from charging, or requesting donations, for any 
such copies, however made; and from distributing the software and/or 
documentation with other products (commercial or otherwise) without prior 
written permission, with one exception: Disk Vendors approved by the 
Association of Shareware Professionals are permitted to redistribute 
PhoneWorks, subject to the conditions in this license, without specific written 
permission.

Unregistered use of PhoneWorks after the 30-day evaluation period is in 
violation of federal copyright laws.
Evaluation and Registration

This is not free software.    This license allows you to use this software for 
evaluation purposes without charge for a period of 30 days.    If you use this 
software after the 30 day evaluation period a registration fee of $30 is required. 
Payments must be in US dollars drawn on a US bank, and should be sent to 
CIMware,    P.O. Box 13313, Atlanta, GA 30324.    Credit card ordering and quantity
discounts are available, as described in the section Ordering Information/Order 
Form.    When payment is received you will be sent a registered copy of the latest
version of PhoneWorks.

One registered copy of PhoneWorks may be dedicated to a single person who 
uses the software on one or more computers or to a single workstation used by 
multiple people.

You may access the registered version of PhoneWorks through a network, 
provided that you have obtained individual licenses for the software covering all 
workstations that will access the software through the network.

Governing Law

This agreement shall be governed by the laws of the State of Georgia.



Disclaimer of Warranty

This software and the accompanying files are sold "as is" and without warranties 
as to performance of merchantability or any other warranties whether expressed
or implied.    Because of the various hardware and software environments into 
which PhoneWorks may be put, no warranty of fitness for a particular purpose is 
offered.

Good data processing procedure dictates that any program be thoroughly tested 
with non-critical data before relying on it.    The user must assume the entire risk 
of using the program.    Any liability of the seller will be limited exclusively to 
product replacement or refund of purchase price.



Revision History

Revision 1.1
1. Fixed intermitent problems related to turning modem speaker on and off.
2. Fixed problem which caused the wrong button bitmap to be loaded.
3. Fixed problem which occured if About box was displayed when no phones were 

displayed.
4. Enhanced button display on phone form to display buttons based on screen 

resolution.
5. Enhanced speaker button to detect the speaker mode in the init string.

Revision 1.2
1. Added a note option under the Options menu. This will start up any text editor for 

taking notes. By default PhoneWorks uses the Windows Notepad, but, this can be 
changed using the menu item Edit Preferences Text Editor.

2. Added an edit buttons option on the button selection form. By default this option will 
option will start Windows Paintbrush allowing buttons to be edited. The bitmap editor 
can be changed using the menu item Edit Preferences Bitmap Editor.

3. Added more help which describes how the button bitmap file and the alphabetic 
conversion file can be customized.

4. Provided better support for pulse dialing.
5. Added multi-level menu jumps to allow easier and more accurate navigation through 

voice messaging menus.
6. Added a calendar option which allows calendar dates to be entered easily. This 

feature is great for checking frequent flier mileage on specific dates, or checking 
bank deposits.

7. Added a password feature which masks out the number in the dialer when the 
button's description is "Password".

8. Credit card purchasing was added as a purchasing option in the ordering forms.



Date Formatting

Date formatting determines how dates are dialed when a date is selected using the calendar.
Mask Displays as:

M 1
MM 01

MMM Jan
MMMM January

D 1
DD 01

DDD Mon
DDDD Monday

YY 94
YYYY 1994

More



Date Masks
d Display the day as a number without a leading zero (1-31).
dd Display the day as a number with a leading zero (01-31).
ddd Display the day as an abbreviation (Sun-Sat).
dddd Display the day as a full name (Sunday-Saturday).
ddddd Display a date serial number as a complete date (including day, month, and 

year) formatted according to the Short Date setting in the International 
section of the Windows Control Panel.    The default Short Date format is 
m/d/yy.

dddddd Display a date serial number as a complete date (including day, month, and 
year) formatted according to the Long Date setting in the International 
section of the Control Panel.    The default Long Date    format is mmmm dd, 
yyyy.

w Display the day of the week as a number (1 for Sunday through 7 for 
Saturday.)

ww Display the week of the year as a number (1-53).
m Display the month as a number without a leading zero (1-12).    If m 

immediately follows h or hh, the minute rather than the month is displayed.
mm Display the month as a number with a leading zero (01-12).    If m 

immediately follows h or hh, the minute rather than the month is displayed.
mmm Display the month as an abbreviation (Jan-Dec).
mmmm Display the month as a full month name (January-December).
q Display the quarter of the year as a number (1-4).

y Display the day of the year as a number (1-366).
yy Display the year as a two-digit number (00-99).
yyyy Display the year as a four-digit number (100-9999).




